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Key Points for Presentation | e e

=

1. Describe the work | do making
accessible content for CIDI.

2. Explore the three most
important considerations in
accessible content: design,
images, and navigation.

3. Outline best practices for
creating accessible content in
Microsoft Word Docs, PDF Files,
and PowerPoint Presentations.




CIDI’s Products and Services include: E-Text, Braille, Captioning and

Described Media, Assistive Technology Demos and Evaluations, ICT

Accessibility Trainings and Website Evaluations
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Who Uses Accessible Media e bl

The audience for Accessible Media is not just people with disabilities. It is far larger than
you would imagine:

* Individuals who are blind, or experience color blindness or low vision
e Students with mobility issues who cannot hold a textbook

e Students with motor disabilities who cannot turn pages

e The Deaf and Hard of Hearing Community

e Students with learning disabilities such as dyslexia or ADHD

e Students with head injuries, trauma, or cognitive disabilities

e Auditory learners

e Aging population



What Needs to Be Accessible? Regtlsssgadira i

Ideally, everything in an educational environment or posted online should
be made accessible:

e Textbooks and Course Materials

e Course Syllabi and Exams
e Handouts
e Courses Websites

e Readings and Course Packets




3 Tips for Greater Accessibility IRESEs=astir I

Keep these 3 ideas in mind for greater accessibility across all programs:

1. Are my design choices accessible?
Have | chosen fonts, colors, and backgrounds that are easy to discern?

2. Are my visuals clearly and fully described?
Have | written alternative text descriptions and captions for my images?

3. Is my content easy to navigate?
Have | created headings and bookmarks for easy navigation?



Accessible Design Choices A

e Font size (12 pt. minimum). e |f you must use graphics, try to convey
the meaning in text as well, and always
provide a caption and alt text
description.

e Sans serif fonts are best (Calibri, Arial,
Verdana, Helvitica, Geneva).

* Avoid large amounts of italicized,

bold, underlined, or capitalized text. * Explain all acronyms, symbols, and

abbreviations for your audience at the

e Color contrast should reduce eye top of the page, not the bottom.
strain (yellow text on black

background is most accessible).  Provide meaningful context for

hyperlinks whenever possible.
e Do not rely on color coding alone to

, e QOrganize material with clear headings
convey meaning.

and logical structure.



Alternative Text Descriptions el et o R I
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All images in a document should be fully described using proper
capitalization, grammar, spacing, and punctuation.
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Format Picture
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4 TEXT BOX

To add alternative text:

Vertical alignment

T o * Right-click on the image.

Resize shape to fit text

Allow text to overflow shape

e Choose Format Picture.

I;' e Select Layout Properties icon.
e e Click on the Alt Text link.
 Type in the description field.

Vincent van Gogh's 1891 painting entitled Blossoming Almond Tree.

e Do not use hard line breaks.



How to Describe Images A
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 First summarize what you see in
one general informative
sentence.

 Keep your description neutral
and informative.

e Use proper grammar, spelling
and punctuation.

 Avoid acronyms and symbols.




How Much Is Too Much? e bl

e Best practiceis 125
characters, or the length of a
Tweet.

e The default setting for JAWS
screen reading software
pauses after 250 characters.

e However, depending on
purpose or audience, alt text
can get quite long.



Consider Cognitive Load

Cognitive load, also referred to as
Auditory Fatigue, is something to consider
when writing alternative text, so that you
don’t overwhelm the listener.

If there is too much information contained
in an alt text, it is best to shorten the alt
text and add a table or list to accompany
the image. This table or list can hold the
information in a more logical way.

Keep your alt text descriptions as concise
as possible and edit out repetition. Also
try to group items so your description is
easier for someone to process.
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Microsoft Word Accessibility A

. Choosing accessible fonts and design features.

. Creating multiple levels of headings for navigation.

. Generating an automated table of contents.

. Writing alternative text descriptions and/or captions for images.

. Creating accessible numbered and bulleted lists.

. Establishing a logical reading order.

. Formatting accessible tables and not using tables for layout purposes.

. Creating white space with page layout tools (not tab, enter, space bar).
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. Using column breaks, section breaks, and page breaks.

10. Using the accessibility checker to find and fix errors.



Adding Headings for Navigation Regsfssmsasisrat I

View EasyProducer Add-Ins Acrobat

As 3 Find -

- A .I

=g T AaBbCcDc AaBbCcDc | AaBbCi AaBbCc “_711 3 Replace
e o

Jy v e TMormal 1 Mg " | Headingl | Heading2 _ Change
_ ) ’ Styles - g Select =
Styles Editing

e Add Headings to Microsoft Word Docs for easy navigation
and to mark important chapters or subsections.

 Highlight a word or line in your document and select a
Heading Level in the Styles group on the Home Ribbon.

e To view all Headings within your document, click on the View
Tab and check the Navigation Pane box.



The Navigation Pane in Word e h || Betion tmd Tnovasion
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Using Accessible Spacing A

=

 Only adjust spacing using page layout, line spacing, section breaks, and
ruler. Do not hit enter or tab repeatedly to create white space.

e Create columns with Microsoft Word’s formatting tools, not by tabbing or
creating a makeshift table to arrange text.

* Inserting section breaks and adjusting your margins can help you change
the layout of your page if necessary.

PAGE LAYOUT REFERENCES MAILINGS REVIEW

ks - Indent Spacing
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Creating Accessible Tables A

Tables should:

e Have a header row.

e Have alogical reading order.

e Contain related information.

e Consist of the same number of cells in each column and row.

 Have a title and caption that gives an overview of what’s inside the table. If
placed before the table, it allows students to focus and interpret the data.

 Have structural alt text that describes the organization of the table, ie. “A table
with 3 columns and 10 rows. The column headers are Faculty, Course Number,
and Course Description.



The Accessibility Checker A

Accessibility Checker

Inspection Results

Click the
error

ERRORS

e Save your document as a .docx file. 4 Missing At Tex
Tab.e
e Go to the File tab and click on Check for Issues, I
and select Check Accessibility. erout o S o 10 information i
Unclear Hyperlink Text (11) ab%ﬁv\:?heydto
e The accessibility checker will open in a separate Ceperted Bk a5 (199 | et o,
pane and list all accessibility issues with links to .
each potential problem.
e Additional information appears below, instructing
you on why this might cause a problem and how to Addiional Information .
fix the issue. s s ot

presented in pictures and other objects.

To add alternate text to a table:

Select and fix each issue listed above to make this document
accessible for people with disabilities.

Read more about making documents accessible




PDF Accessibility | e e

Save as PDF from MS Word to retain accessibility features.
Text is accessible and highlights in proper reading order.
Bookmarks provide organization and easy navigation.
Pagination is clear and navigable.

Tags are present, or the file is autotagged.

File size is manageable, ideally under 25 MB.

File names are clear and contain no symbols.

Images have alt text descriptions if necessary, using T.U.R.O. tool.

Jo b=l buogm By Y [

Language and metadata are included in document properties.

10.Color contrast is high for ease of reading.



The Bookmarks Pane in Adobe [ReESiassasdiar i

Bookmark p 4
e To adjust the hierarchy
=]~ [ 43 of your bookmarks,
drag them up and
=[] Acing Business Associations: A Checklist under the “parent
Approach to Business Associations bookmark” so they
| Acknowledgements appear indented.
| Table of Contents * You can edit the text of

a bookmark, to include
the word “Chapter” for

Chapter 1: Agency instance.

- Introduction

21

Chapter Z2: General Partnerships

21

Chapter 3: The Structure of the Corporation

2
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Adding Alt Text to a PDF File [Regsesstasiseasin

) Figure - No alternate text exists.

EW"N '~ as figL —

Y g as fig

To add alt text descriptions to images in a PDF file, it’s easiest to turn on
T.U.R.O. in the Accessibility Tools, which stands for “Touch Up Reading Order.”
This highlights all figures for you, and you can then right click on the ones
needing descriptions and select “Edit Alternative Text.”




Accessibility Report

* You can also generate an
Accessibility Report in the
Accessibility Tools options.

e Click on “Full Check” to open a list
of things you’d like your check to
include, such as figures missing alt
text, missing bookmarks, errors in
reading order, color contrast, not
having a language selected, etc.

Georgia Jh Center for Inclusive
Tech|/Design and Innovation

Accessibility Checker Options =

L%

Report Opticns

| Create accessibility report Faolder: ChUsers\wmorrison8\Documents Choose...

Attach report to document

Page Range

@ All pages in document Pages from 222 to [222

Checking Options (31 of 32 in all categories)

Category: | Document -

| Accessibility permission flag is set

| Document is not image-only PDF

| Decument is tagged PDF

| Decument structure provides a logical reading order
o | Text language is specified

| Document title is showing in title bar

| Bookmarks are present in large documents

| Document has appropriate color contrast

| SelectAll | | ClearAl

| Show this dialog when the Checker starts

Help | Start Checking | | Cancel




PowerPoint Accessibility A

Use Layout Templates so that all text is visible in the outline view.

All slides should have unique titles for easy navigation and clarity.
Choose fonts and color contrast for greatest visibility.

All graphics/images should have brief alternative text descriptions.
Create white space with page layout tools (not tab, enter, space bar).
Tables should have a header row, alt text description, and caption.
Lists should be created with the bullet and list toolbar buttons.

Reading order can be adjusted in the Selection Pane.

o by =y b o> Y =

Add metadata (title, author) on the File Tab.

10. Use the built in checker to create an accessibility report.



Accessible Layouts A

T
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Unique Slide Titles

e Each slide should have a unique
descriptive title to help
someone navigate through the
presentation.

e Slide titles help everyone
understand and focus on your
key points.

e C(Clear organization and logical
section breaks help your
audience know where they are
in your presentation.

10

1"
12

13

14
15
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DNA Stores Genetic Information as a Sequence of Nucleotides

« DNA 15 a nucleic acid composed of two strands of polynucleotides twisted to form a double
helix.

= Four different nucleotides make up polynucleotides and can be found in the DNA of all cells.

The Genome Is the Total DNA-Based Information
Held in the Chromosomes

Generally, Complex Organisms Have a Larger Genome and a Larger Number of Genes
Most Genes Code for Proteins, Which Generate Phenotypes

A Unique Set of Genes Is Expressed in Each Specialized Cell Type

The Three-Dimensional Structure of DNA

DNA's Structure Explains Its Function

=« Base pair is the term for two nitrogenous bases held together by hydrogen bonds in a DNA
molecule.

= Base-pairing rules, first proposed by Watson and Cnck, state that a base on one strand of DNA
pairs exclusively with a corresponding base on the other strand, resulting in two
complementary stands of DNA.

DNA Stores Information in the Order of the Bases in the Polynucleotide Chain
DMNA Replication Is Semiconservative

Few Mistakes Are Made in DNA Replication



Selecting Reading Order A

) . Selection and Visibility v X
e In the Drawing section, select Arrange >
Selection Pane... Shapes on this Slide:
* |n the Selection and Visibility pane, all the Ficture 16 =
elements on the slide are listed in reverse . —
Picture 13 b
order. The tab order of objects begins at —
the bottom of the list and tabs upwards. Content Placeholder 8 7
 Elements can be re-ordered using ’Fhe Text Placeholder 5 E
arrows at the bottom of the Selection and —
Visibility pane. Tite 1 -

 The fewer objects on a slide, the more
accessible for someone using a screen
reader to listen to content aloud.



Accessible Table Data

Physical Properties

of the Giant Planets

Jupiter | Saturn Uranus @ Neptune

Orbital semimajor axis 5.20 98 19.2 30
(AU)

Orbital period (Earth 11.9 29.5 84.0 164.8
years)

Orbital velocity (km/s) 13.1 9.7 6.8 54
Mass (M__ =1) 317.8 95 14.5 17.1
Equatorial radius (km) 71 490 60,270 25,560 24 300
Equatnrial radius 11.2 | 95 4.0 3.8 -
(A, =1)

Oblateness 0.065 0.098 0.023 0.017
Density (water = 1) 1.33 0.69 1.27 1.64
Rotation period (hours) 9.9 10.7 17.2 16.0
Tilt (degrees) 3.13 26.7 07.8 28.3
Surface gravity 253 1.07 .89 1.14

(relative to Earth's)
Escape speed (km/s) 595 35.5 21.3 23.5

Georgia [ﬂ] Center for Inclusive
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Pictures of tables or graphs with data should
have full image description, and true accessible
tables that accompany them.

Structural alt text for tables allows someone a
chance to hear what the table contains and
decide if it’s relevant before listening to all the
data cells.

Example: Table 10.1 is titled Physical Properties
of the Giant Planets. It has 5 columns and 13
rows. The column headings are Physical
Property, Jupiter, Saturn, Uranus, and Neptune.

*Please note that because the first column heading was left
blank, we filled it in so that the table would make more sense.



Using the Accessibility Check

Georgia [[E Center for Inclusive
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To access the Accessibility Checker, go to the File tab and click Check for Issues

From the drop down menu, select Check Accessibility

_ Prepare for Sharing
- j Before sharing this file, be aware that it contains:

Document properties, author's name and cropped out image data
Check for

Jssues v Footers

Content that people with disabilities are unable to read

Prepare for Sharing
Bt ord shanneg this File, be raarg TR f Confaing
Dhooument propertes, authoe's neme and cropped L image data

C kel T
Foabers

Josiees -
P mar Ty gl e e el o mbaletypt Gt @ pfialEle te remsd
[Pkt DasriidmEnd

=0 CiEdo <t Al

Checl fcoeys baliety

@ Che e Bhe dooument o condend that people
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Have Further Questions?
W e

Contact our Customer Support Team
by phone (404) 894-7756 or by email
cidi-support@design.gatech.edu

CREATING THE NEXT"*
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